
Troubleshooting

If you are having problems using HiJaak PRO, or if you are getting unexpected 
results, you can find possible solutions in this help file. For troubleshooting help, 
click on one of the following topics: 

Basic Look of an Image
Colors
Conversions and Formats
DOS Capture
HiJaak Browser
Import into Other Applications
Networks
Opening
Printing
Scaling and Resizing
Text and Fonts
TWAIN
Windows Capture
It used to work, and now it doesn't?

Note: This Troubleshooting help file is dated 7/30/93. An updated version may exist 
on the Inset Systems BBS. It can be reached 24 hours a day at 203-740-0063.    You 
can also obtain an updated Troubleshooting file by logging on to CompuServe and 
typing GO INSET.



Basic look of an image

Problems with The Way Your Image Looks
If your opened, processed or converted image doesn't look the way you expect it to,
there may be a way to fix it.    Click on one of the following topics for more 
information.

Parts of my image are missing
My rotated image doesn't look right
Undo doesn't undo all my changes
Every image I open looks bad

Note: If your image looks bad after performing multiple processing operations on it,
try saving and re-opening the image between each operation.



Parts of my image are missing

Q. Why are some elements of my vector image missing?
A. If elements (lines, arcs, etc.) the same color as the background are not visible, 

use Reveal Background Color Objects to restore the image. This option sets 
initially invisible objects to a color that contrasts with the background.

Q. Why does changing my color raster image to black and white result in 
the loss of part(s) of the image?

A. If you try to force a raster image to black and white, it may appear to lose some 
part(s) of the image, or even result in an all black or an all white image.    This 
may indicate that HiJaak PRO's selection for what colors to make black and what 
colors to make white is inappropriate for the image you are working with.    Use 
the Change a Color option from the Colors menu to manually change your 
colors to the appropriate black and white output.    HiJaak PRO remembers your 
color changes, and gives you the option to apply them in future similar 
conversions.



My rotated image doesn't look right

Q. Why does my DOS text screen capture display incorrectly when I rotate 
it in HiJaak PRO?

A. HiJaak PRO is capable of rotating text screen captures in increments of 90 
degrees without distorting the images. Other rotation values could cause image 
quality to suffer.

Q. After I rotate my PCL file, why do my fonts change?
A. The PCL4 used by HiJaak PRO in emulation of the LaserJet II does not provide for 

the rotation of fonts. HiJaak PRO substitutes an already-rotated font whenever 
text in a PCL file is rotated. That may cause the look of the PCL file to change. To 
avoid the change in font, convert the PCL file to PCX and then back to PCL. The 
conversion through PCX will cause text to become bitmapped representations of 
the original font. Subsequent rotation of the PCL file will not change the 
appearance of the text.

Q. Why does a colored background appear when I rotate an image after 
using the Optimize Palette option on it?

A. When an image is rotated a number of degrees that is not an even multiple of 90,
the resulting image will no longer fit into the rectangular window available for it. 
HiJaak PRO must pad the image with pixels of a certain color to fill out the 
rectangular window. Whenever possible, HiJaak PRO will fill out the image with 
the background color selected under Setup and Preferences. However, if palette 
optimization is used on an image before rotation, the optimization may, in fact, 
eliminate the background color from those available for the particular image. 
Another background color -- one that is available in the new optimized palette -- 
is selected to fill out the image window. To ensure that no color substitution takes 
place, rotate the image before selecting optimize palette. Performing the rotation 
first will introduce the background color into the image and it will be preserved as
part of the palette through the optimization process.



Undo doesn't undo all my changes

Q. The Edit/Undo menu item appears to undo only the last change I have 
made to my raster image. Is there a way to undo all the changes I have 
made?

A. The Undo option for raster images is limited. If you will be performing multiple 
processing options on a raster image, you may want to select View/ Clone View 
first (Alt+v, l). Clone View creates an on-screen copy of your active image. You 
can then process the clone and compare its quality to the original. If you wish to 
discard changes you have made to the clone, simply close the clone image.



Every image I open looks bad

Q. Why does every image I open look bad?
A. HiJaak PRO may be having difficulty determining the proper display card type. If 

you know your display mode, you can set HiJaak PRO manually by using a text 
editor (such as MS-DOS Edit or Windows Notepad) to open the HJPRO.SET file 
found in your Windows subdirectory and adding the following line:

DISPTYPE=XX

where XX is the display type number appropriate for your system. 
You can also add the line by typing it    in the Command dialog box (Alt+f, m). For 
example, if your display is a Diamond Viper in 16 million color mode, type the 
following:

+DISPTYPE=10

Valid display type values and their corresponding display modes are shown below:

2 BGR888 - 24-bit modes (16 million colors)
3 RGB888
4 RGB555 - 15-bit modes (32 thousand colors)
5 BGR555
6 RGB565 - 16-bit modes (64 thousand colors)
7 BGR565
8 RGB655
9 RGB664
10 RGB8888 - 32-bit mode (16 million colors, Diamond Viper 

card)

Q.    Why do I get vertical stripes in my images when I open them in HiJaak 
PRO?

A.  We know that this problem sometimes occurs with the #9 S3 video card when 
Bitmap Caching is enabled. Changing the setup of your video card can help: from 
your #9 S3 video card setup program, disable Bitmap Caching. Restart Windows 
and HiJaak PRO and open an image. It should now view properly.



Colors

Problems With the Colors in an Image
If the colors in your image do not look right, click on the problem below that most 
closely matches your situation:

The colors in my images are all wrong!
The image has strange patterns throughout
The image is too light or too dark
The image looks like a photo negative
Invert colors doesn't seem to be working right
My black and white print-outs of color images look bad
My color changes don't appear correctly or colors seem to be changing for no 
reason
My grayscaled image looks bad
Palette Optimization seems to have no effect
Reverse Black and White seems to have no effect
When I reduce colors, the image looks bad



The colors in my images are all wrong!

Q. Why does every image I open seems to have the wrong colors?
A. HiJaak PRO may be having difficulty determining the proper display card type. If 

you know your display mode, you can set HiJaak PRO manually by using a text 
editor (such as MS-DOS Edit or Windows Notepad) to open the HJPRO.SET file 
found in your Windows subdirectory and adding the following line:

DISPTYPE=XX

where XX is the display type number appropriate for your system. 
You can also add the line by typing it    in the Command dialog box (Alt+f, m). For 
example, if your display is a Diamond Viper in 16 million color mode, type the 
following:

+DISPTYPE=10

Valid display type values and their corresponding display modes are shown below:

2 BGR888 - 24-bit modes (16 million colors)
3 RGB888
4 RGB555 - 15-bit modes (32 thousand colors)
5 BGR555
6 RGB565 - 16-bit modes (64 thousand colors)
7 BGR565
8 RGB655
9 RGB664
1
0

RGB8888 - 32-bit mode (16 million colors, Diamond Viper 
card)

The image has strange patterns throughout

Q. Why is there a box-like pattern in my image?
A. Using Dither in HiJaak PRO not only "blends" colors from the Windows palette to 

approximate the colors of your original image, but it blends them in a distinct 
pattern.    If this box-like pattern is very obvious, you may want to use Diffuse, 
which blends colors from the Windows palette in a more random pattern. Note 
that Diffuse takes longer.

Q. Why is HiJaak PRO's default Reduction Method set to Dither?
A. HiJaak PRO uses Dither because it's the quickest way to get the best displays of 

images that contain more colors than are available in your Windows palette. 
Snap is faster than Dither, but the results aren't as good.

Q. Why are there "worming" patterns in my image?
A. When using the Diffuse option, this is always a potential problem. Use the 

Dither option and see if you get better results. Colors in your image that are not 
available in your Windows palette must be approximated using either Dither or 
Diffuse patterns.    Choose the one which gives you the best results.





The image looks too light or too dark

Q. How do I convert a captured screen with a dark-colored background to 
grayscale and get an image that is not too dark?

A. Set Brightness up to +15 or +20 to lighten the image overall.    If only the 
foreground is too dark, use Contrast at about +15 or +20 to lighten the 
foreground.

Q. How can I lighten the middle-range of colors, while leaving extremely 
light and extremely dark areas alone?

A. To lighten mid-range areas, increase the Gamma Correction. Pull down the 
Colors menu and select Contrast and Brightness (Alt+o, b).    In the Contrast 
and Brightness dialog box, increase the Gamma Correction until the 
thumbnail looks as you want your image to look.    Click on OK.

Q. My image appears to be all approximately the same muddy color.    How 
can I see the differences in the colors more clearly?

A. When the tones represented in your image appear to be basically the same color
or colors throughout the image, use Histogram Equalization to perform an 
analysis of the tones and separate them evenly to produce a clearer-looking 
image. Pull down the Colors menu and select Contrast and Brightness (Alt+o, 
b).    In the Contrast and Brightness dialog box click on the      Histogram 
Equalization check box (Alt+q). Note that this option will have little effect on 
images in which the tones are already spaced evenly.

Q. Why does the color white sometimes appear as a light pattern in my 
printouts?

A. What shows up on your monitor as white may, in fact, be slightly off-white or a 
light gray. Because it usually has just black ink or black toner to represent 
shades, your printer must show the light gray as a halftone pattern. The halftone 
patterns generated on high resolution output devices, such as image-setters, will 
produce good-looking, highly accurate results. On lesser resolution devices, it 
may be necessary to experiment with different brightness setting to produce the 
best printed results.



The image looks like a photo negative 

Q. Why does my displayed image appear as a photographic negative?
A. In certain situations, the color palette is inverted producing the effect of a 

photographic negative.    Pull down the Colors menu and select Invert Colors to 
restore the proper colors (Alt+o, i).



Invert Colors doesn't seem to be working right

Q. Why is the Invert option switching black and white to other colors    
instead of reversing them?

A. Invert is used not to reverse black and white, but to invert the entire color 
palette.    If you need to interchange black with white, pull down the Colors menu
and select Reverse Black and White (Alt+o, r).



My black and white print-outs of color images look bad 

Q. How do I achieve the clearest possible black and white printout of a 
color line-drawn vector image?

A. Pull down the Colors menu and select All Colors to Black (Alt+o, c); every non-
white object in a vector image will become black.    A printout will show solid 
black objects and lines.

Q. How do I get a clear black and white printout of my raster image?
A. If you are printing to a dot matrix or LaserJet printer, select the Grayscale option

and click on the Reduce Colors button.    In the Reduce/Expand Colors dialog 
box, select Number of Colors=2, and a Reduction Method of Snap. HiJaak 
PRO will look at the colors in the file and determine whether they are closer to 
white or black and snap each color to either black or white.    For instance, yellow 
is closer to white and will become white.    Blue is closer to black and will become 
black.    If you were to use All Colors to Black instead of the options listed 
above, you will most likely get an all black image.    

A. If you are printing to a PostScript language printer, select the Grayscale option, 
but leave the Number of Colors the same using the Snap Reduction Method.

Q. Why does the color white sometimes appear as a light pattern in my 
printouts?

A. What shows up on your monitor as white may, in fact, be slightly off-white or a 
light gray. Because it usually has just black ink or black toner to represent 
shades, your printer must show the light gray as a halftone pattern. The halftone 
patterns generated on high resolution output devices, such as image-setters, will 
produce good-looking, highly accurate results. On lesser resolution devices, it 
may be necessary to experiment with different brightness setting to produce the 
best printed results.



My color changes don't appear correctly, or colors seem to be changing for
no reason

Q. Why does changing a color in my 24-bit raster image change other 
similar colors too?

A. This is a feature of the Change a Color option which will change the color you 
select, as well as change similar colors within a certain tolerance.    Because 24-
bit images commonly have gradient fills that are nearly undetectable, this allows 
you to change the whole area with only one color change.

Q. Why does HiJaak PRO appear to be changing the colors of some objects 
in my DXF file?

A. DXF images will open with Reveal Background Color Objects selected as 
default, mimicking the behavior of AutoCAD.    If there are objects the same color 
as your chosen background, HiJaak PRO will automatically change those objects 
to a contrasting color so they are visible.

Q. Why do I get unexpected results when I change colors in my DXF file?
A. Because HiJaak PRO mimics AutoCAD's default of Reveal Background Color 

Objects, when objects would otherwise blend into the background color, it will 
sometimes respond unexpectedly to a color change that is to be performed on an
already changed object or line.    Though an object may appear to be one color 
on-screen when performing a color change, the HiJaak PRO color selector is 
reporting the true object color as indicated in the image file.

Q. Why aren't the colors in my 256 color image viewing properly?
A. ATI Ultra graphics cards with Mach 32 drivers and chips have an option to turn off

the 256 color palette.    With the 256 color palette turned off, HiJaak PRO will not 
view the colors properly.

A. If you are using a standard Super VGA graphics card and you are not running 
Windows in a 256 color mode, you will not be able to view an image with 256 
colors properly.    Windows cannot supply enough colors from its palette for HiJaak
PRO to view it properly.

          Either select a graphics mode from Windows Setup that supports 256 colors (if 
your graphics card supports it), or display the image using the Reduction 
Method of Dither or Diffuse in HiJaak PRO.    Reduction methods will not display 
exact colors, but will blend the colors available in the Windows palette to produce
a more attractive image.

Q. Why does a colored background appear when I rotate an image after 
using the Optimize Palette option on it?

A. When an image is rotated a number of degrees that is not an even multiple of 90,
the resulting image will no longer fit into the rectangular window available for it. 
HiJaak PRO must pad the image with pixels of a certain color to fill out the 
rectangular window. Whenever possible, HiJaak PRO will fill out the image with 
the background color selected under Setup and Preferences. However, if palette 
optimization is used on an image before rotation, the optimization may, in fact, 
eliminate the background color from those available for the particular image. 
Another background color -- one that is available in the new optimized palette -- 



is selected to fill out the image window. To ensure that no color substitution takes 
place, rotate the image before selecting optimize palette. Performing the rotation 
first will introduce the background color into the image and it will be preserved as
part of the palette through the optimization process.

Q. I've used Change a Color to change color A to color B but then decided 
to reverse the process by using Change a Color to set color B back to 
Color A. Now whenever I perform any processing on my image I see it 
repaint first in color A then Color B and then Color A again. How can I 
halt this process?

A. Color changes in HiJaak PRO do build one upon another. To eliminate the 
repaints, you must also eliminate the color changes that are causing the repaints.
Do this by selecting List Color Changes from the Colors selection on the Main 
menu.



Palette Optimization seems to have no effect

Q. Why doesn't Palette Optimization improve the output image?
A. Palette Optimization only has an effect if you reduce the number of colors in the 

output image.



Reverse Black and White seems to have no effect

Q. I selected Reverse Black and White and it did not have any effect on my
image.

A. Often colors that appear to be black or white are actually not true black and true 
white.    Reverse Black and White only reverses true black and true white.    If 
this option seems to have no effect on your image, you probably don't have any 
black or white in the image. The colors that appear as black and white probably 
do because your image has more colors than can be displayed; therefore, very 
dark colors will be represented on the display as black, and very light colors will 
be represented in the display as white.



When I reduce the Number of Colors, the image looks bad 

Q. How do I reduce the number of colors and still get an attractive image?
A. If you wish to reduce a 16 million color image to 256 colors, you should use 

HiJaak PRO's different palette options to get the best results.    Use the 
Reduction Method of Dither or Diffuse, and select the Optimize Palette 
option from your Reduce/Expand Colors dialog box for best results.



 My grayscaled images look bad

Q. Is one format better to use for grayscaling?
A. The TIFF format supports entirely grayscale palettes, and so is much better to 

use when converting to grayscale images.    Other formats such as PCX must use 
combinations of black and white to approximate grays.

Q. Why do I occasionally see strange colors appearing in my image when I 
make it grayscale?

A. The presence of non-gray colors in a grayscale image will occur most often when 
dealing with 16-color images or running Windows in a 16-color graphics mode. 
There may be no grays or few grays in the palette available to HiJaak PRO in 
those circumstances. HiJaak PRO is forced to substitute another available color 
for the unavailable gray or grays.



Conversions and Formats

For help with conversions, click on the format below that you are converting to or 
from:
BMP
CGM
GEM
IGF
JPEG
PCL
TIF
TXT

If none of the above topics apply, click on the following:
General conversion problems



BMP

Q. Why have I noticed the file sizes of some BMP files increasing when I 
use HiJaak PRO's RLE compression for that format?

A. The RLE compression type is effective only when a BMP image has a large 
number of similarly colored dots (or pixels) in close proximity to each other. Other
types of BMP files may not be compressed at all when the RLE flavor of BMP is 
selected, and some may actually grow in size.

Q. Why do I occasionally see a black line across the top of DOS text screen
captures that have been converted to BMP?

A. A typical DOS text screen capture will show gray text on a black background. In 
converting this screen to BMP and processing it to a black text on white 
background (using the Reverse Black and White option), a black bar may be 
introduced across the top of the image. To achieve the same clean black on white
appearance without the line, you may choose to use the Change a Color 
selection under the Colors selection from the main menu to map the black 
background to white. The gray text may then be mapped to black by the same 
process.



CGM

Q. Conversions of Text files to CGM result in a zero-length file or an empty 
image. What can I do to get a successful conversion of TXT to CGM?

A. Text to CGM conversions produce blank images or zero-length files when the 
conversion is done with the Stroke Fonts option set to on. To correct the 
problem, de-select the Stroke Fonts option.



GEM

Q. Why does my conversion to GEM create an image with incorrect colors?
A. The GEM format uses a fixed color palette, so conversions from formats without 

the same palette limitation may produce undesired color changes in GEM. To 
remedy this problem, use HiJaak PRO's Change A Color option under the Colors
menu to remap colors in the source image to the desired colors in the fixed GEM 
palette.



IGF

Q. How might I speed up the conversion of text screen capture IGF files to 
other formats?

A. The conversion of text screen capture IGF files to other formats will be 
particularly time-consuming when the captured screen includes the dotted text 
characters often used in screen backgrounds and shading. Each dot in those 
characters must be mathematically calculated and positioned by HiJaak PRO 
during a conversion. To speed the conversion, select Rasterize Text from the 
DOS Capture Options screen accessed through the Capture menu selection. 
This will cause DOSCAP to take a bitmapped picture of the objects on your DOS 
text screen and will eliminate the need for much of HiJaak PRO's conversion 
calculations.

Q. My DOS text screen capture does not include any peculiar shading 
characters or anything that should hold up the conversion process. Why 
else might conversions from text IGF files take too long?

A. Through the course of revising the text IGF format for this release of HiJaak PRO, 
two separate fonts were created by Inset Systems. The first, IBMPCMED, was 
made available to users of HiJaak for Windows 1.0 to remedy some text screen 
capture problems that had been encountered and was also included in some pre-
release testing of HiJaak PRO Version 2. That font was later replaced by 
IBMPCDOS, a TrueType font. If you are among those users who received 
IBMPCMED, it is possible that the presence of that font is slowing down IGF 
conversions and hurting the quality of those conversions. Check for the presence 
of the font using the Fonts selection under the Windows Control Panel. If you find 
IBMPCMED, remove it using the appropriate Control Panel button. Control Panel 
also provides you the option of deleting the font from your hard drive. We 
suggest you do so. The installation of HiJaak PRO should place the newer 
IBMPCDOS.TTF into your list of available fonts. Using this font, HiJaak PRO will be 
able to give you the best quality conversions of your DOS text screen captures in 
the least time.

Q. How can I avoid a Font File Not Found error message when converting 
from a text screen capture IGF file?

A. That error message should only occur if the font IBMPCDOS.TTF was not properly 
installed into Windows during the HiJaak PRO Setup process. HiJaak PRO uses that
font to depict the characters present in your DOS text screen capture. 
Reinstalling the HiJaak PRO product should make the font available to Windows. 



JPEG

Q. Why is there a width limitation when converting to the JPEG format?
A. The Lead DLL used in conversions to JPEG may generate an error message if the 

image being produced is greater than 1,365 pixels in width. The conversion will 
work properly if sizing values, set on the Options menu, are kept to a width less 
than 1,365 pixels. Lead has a revised DLL that does not have the same limitation 
on image width. Information on obtaining that DLL, which runs only in Windows 
Enhanced Mode, can be obtained through Inset Systems technical support.



 PCL

Q. Why does my PCL image have incorrect fonts? What does the Font File 
Not Found error message mean?

A. PCL 4 files, such as those supported by HiJaak PRO, generally contain all 
information that a LaserJet II compatible printer will require for accurate printing 
and will show up with correct fonts in HiJaak PRO. However, some applications 
keep important font information separate from the document information. Those 
applications will produce incomplete PCL files that will probably not function as 
expected in HiJaak PRO and may cause a Font File Not Found error message 
during conversion. For these PCL files to function properly, it is important to enter
the Source PCL Options screen at the beginning of a PCL conversion and 
download the appropriate font files into HiJaak PRO. Downloading of fonts into 
HiJaak PRO will usually not be required for a successful PCL conversion as fonts 
are typically included in the PCL file itself.

Q. What can I do to avoid conversion failures and missing characters when
converting from a PCL file?

A. Previously stored font information may prevent HiJaak PRO from successfully 
converting a source PCL file. A RESETPCL.BAT utility, installed in the HJPRO 
directory, allows for the clearing of old font information. To use the utility, exit 
HiJaak PRO and go to a DOS prompt. Type RESETPCL with the path to your 
Windows directory (typically, C:\WINDOWS) as the command line parameter.



TIF

Q: Why don't I get a K (black) plate when I do separations of a CMYK flavor
of TIFF?

A: The TIFF 6.0 specification was designed as an exchange format for Quark Express
and only supports CMY. If you require a separate black plate and the ability to 
specify the percentage of gray replacement, you must convert to EPS, and select 
the CMYK check box in EPS Options dialog box.

Q: Why isn't there a Gray Replacement option when I convert to a CMYK 
flavor of TIFF?

A: The TIFF 6.0 specification was designed as an exchange format for Quark Express
and only supports CMY. If you require a separate black plate and the ability to 
specify the percentage of gray replacement, you must convert to    EPS and select
options in the Convert To dialog box. In the EPS Options dialog box click on the 
CMYK check box; this will enable the Gray Replacement option.



TXT

Q. Conversions of Text files to CGM result in a zero-length file or an empty 
image. What can I do to get a successful conversion of TXT to CGM?

A. Text to CGM conversions produce blank images or zero-length files when the 
conversion is done with the Stroke Fonts option set to on. To correct the 
problem, de-select the Stroke Fonts option.



 General conversion problems

Q. Why does my image file become corrupted when I am doing a 
conversion from that source to an identically named file in the same 
format?

A. During conversion, HiJaak PRO reads image information from the source file, 
processes it and then saves it to the destination file. If the source and destination
files have the same path and name, HiJaak PRO will be forced to save information
into a file from which it still needs to read information. This activity will corrupt 
the file. Selecting the Overwrite Notification check box in the Save As and 
Convert To screens will provide a warning when existing files are about to be 
overwritten. Changing the path and/or filename of the destination will prevent the
corruption of the source file.

Q. Why doesn't my image rotate when I select Rotate from the Save As... 
Options dialog box?

A. This is a known problem area in HiJaak PRO. We will have a patch to fix the 
problem in the near future. The best workaround is to use the Edit menu's 
Rotate item before you save the image in the format of your choice.



DOS Capture

Problems when trying to use DOSCAP
Certain system configurations and applications may interfere with the operation of 
HiJaak PRO's DOSCAP utility.    For advice on dealing with problems, click on one of 
the following topics:

DOSCAP's limitations
DOS screen captures don't look right
General problems capturing DOS screens
Problems converting DOS screen captures
DOSCAP error messages
If all else fails...



DOSCAP's Limitations

Q. On what networks does DOSCAP run?
A. HiJaak PRO and DOSCAP support Novell Netware up to and including V3.12.    

Other networks have not been tested, therefore, use of HiJaak PRO with other 
networks may not be supported.    
The only known limitation with the Novell network is an incompatibility between 
DOSCAP and the Token Ring driver. Using the Token Ring driver, you may be 
allowed to capture from and save to local drives, but not to network drives.

Q. Does DOSCAP run with DCA Irma boards?
A. DOSCAP is not compatible with DCA Irma boards.

Q. Can I capture screens with DOSCAP while connected to another 
computer?

A. Using DOSCAP to capture screens from remote control or communications 
software, while you have an established connection, may result in a 
disconnection.    If this is the case, set the modem so that the Carrier Detect is 
HIGH, and try again.



DOS screen captures don't look right

Q. Why does my DOS text screen capture display incorrectly when I rotate 
it in HiJaak PRO?

A. HiJaak PRO is capable of rotating text screen captures in increments of 90 
degrees without distorting the images. Other rotation values could cause image 
quality to suffer.

Q. Why do the characters in the DOS text screen I captured show up 
differently in HiJaak PRO?

A. HiJaak PRO internally maps the captured on-screen characters to a special font. If
the font used by HiJaak PRO does not contain appropriate characters for your 
screen capture, the image generated will be inaccurate. In order to produce a 
more accurate image of your screen, pull down the Capture menu and select 
DOS Capture Options (Alt+c, d)    Click on the Rasterize Text check box 
(Alt+r) in the DOS Capture Options dialog box. With this option selected, 
DOSCAP will take a graphical picture of the characters on the DOS text screen 
you are capturing. That will eliminate the need for the internal font mapping 
usually performed within HiJaak PRO. 

Q. How can I change fonts in a DOS text screen capture?
A. HiJaak PRO does not currently permit the changing of fonts in a DOS text screen 

capture. In order to change the font, convert the image to the TXT format first. 
You can then change the fonts in the converted file.

Q. Screen captures brought into PageMaker as TIFF images sometimes 
come in with black and white reversed. What can I do to fix the image?

A. Selecting Image Control under PageMaker's Element menu will allow for 
brightness and contrast and other adjustments to your placed image. Selecting a 
contrast of -50 will reverse black and white in your image.

Q. Why do the scaling options "Page in Width" and "Scale to Window" not 
work with DOS text screen captured IGF images?

A. Due to limitations inherent in the rendering of Windows TrueType fonts, HiJaak 
PRO does not support the use of those scaling options for text screen IGF files.



General problems capturing DOS screens.

Q. Why doesn't DOSCAP load when I double-click on the DOS Capture icon 
in the HiJaak PRO program group?

A. This might happen if you are running Windows in 386 Enhanced Mode using 
"Stealth Mode" of Quarterdeck's QEMM memory manager.    Testing has revealed 
an incompatibility between DOSCAP and the "Stealth Mode." To eliminate the 
compatibility problem, you must disable "Stealth Mode." Open your CONFIG.SYS 
file in a text editor and remove the "ST:M" or the "ST:F" portion of the device line 
calling QEMM386.SYS. If you do not want to modify your CONFIG.SYS file, you can
run DOSCAP by double-clicking on the MSDOS icon in the Windows Main program 
group.    Change to the HJPRO subdirectory and type DOSCAP.

Q. Why doesn't DOSCAP capture the screen from my application when I 
press the hotkeys?

A. DOSCAP may be unable to capture screens from DOS applications running in 
"protected mode." AutoCAD typically runs in protected mode. A similar mode is 
used by Lotus 1-2-3 WYSIWYG. In many cases, it is possible to disable protected 
mode. (AutoDesk technical support may have advice on running AutoCAD in "real
mode.") Inset Systems provides an alternate DOS screen capture utility for use 
when protected mode cannot be disabled. For more information, click on the 
following:

If all else fails...
          DOSCAP will also be unable to capture from graphics mode programs compiled 

with Borland Turbo Pascal v5 and higher, because those programs bypass the 
capturing mechanism used by DOSCAP.

A. This may also happen if you are running a terminal emulation application. Try 
running a Windows-based terminal emulator and capture that screen using HiJaak
PRO's Windows Capture. This should work when the DOS capture fails.

A. This may also happen if you are communicating by modem. Try using a different 
communications package, which may not experience the same interrupt conflicts.
Telix, a shareware terminal package by Exis, Inc.,    is available on our BBS and 
has tested successfully with DOSCAP.

Q. How can I use HiJaak PRO to capture a screen from a DOS application 
that is incompatible with DOSCAP?

A. If you can't use DOSCAP with your DOS application, but you can run the 
application under Windows in full screen mode, press the Print Screen key to 
copy the image to the Windows Clipboard.    You can then paste the image into 
HiJaak PRO for conversion.    Text screens will be black and white.    Use the "OEM 
TEXT" option in the Clipboard Viewer to display the text properly.

Q. Why don't my capture hotkeys work?
A. If you are running a terminal emulation program, and DOSCAP does not pop-up 

when the hotkeys are pressed, it usually means that the emulation program has 
the keyboard interrupts and has remapped the keys; DOSCAP does not have 
access to them. 

A. If you are running a Terminate Stay Resident program (TSR), your hotkeys may 
not activate DOSCAP. A TSR is a program that runs in memory, waiting for you to 



signal it to start by pressing a certain combination of keys or by running a 
command.    Many screen capture and file finding programs are TSRs.    If you are 
running a TSR, unload it and try your DOSCAP hotkeys again.

Q. What should I do when DOSCAP locks up my applications?
A. DOSCAP might lock up your applications if you are running DOSCAP with another 

Terminate and Stay Resident program (TSR) or another program that uses EMS.    
A TSR is a program that runs in memory, waiting for you to signal it to start by 
pressing a certain combination of keys or by running a command.    
To stop your applications from locking up, change your Maximum EMS Usage 
setting: pull down the HiJaak PRO Capture menu and select DOS Capture 
Options (Alt+c, d). You will see the DOS Capture Options dialog box.    In the 
Max EMS field, type 0 (zero) (Alt+m, 0). Zero is the default setting.

Q. My graphics card is not listed in DOS Capture Options in HiJaak PRO.    
What graphics card type should I select?

A. If you do not find your graphics card listed in the DOS Capture Options dialog 
box,    in the DOS Capture Options dialog box, select IBM-VGA.    This should 
work in most cases, except when running a DOS application that runs in a high 
resolution mode.

A. If you do not find your graphics card listed in the interface, find out what chipset 
it uses and select a driver that uses the same chipset.    If you are unsure of which
available driver to select, call Inset Systems Technical Support at 800-374-6738.

Q: Why does my video display become corrupted when I press the DOSCAP
hotkeys?

A: If you have a Compaq QVision card this might happen because of a known bug in
the svga.scr file. A file to fix this bug is locted on the Inset Systems BBS (740-
0063). Download the svga_new.exe file and copy into your HJPRO directory. Run 
this self-extracting archive    by typing SVGA_NEW at the HJPRO DOS prompt. This 
will overwrite the svga.scr file with a new one that will correct this problem.

If you cannot attach to the Inset Systems BBS, call Inset Technical Support.



Problems converting DOS screen captures

Q. How might I speed up the conversion of text screen capture IGF files to 
other formats?

A. The conversion of text screen capture IGF files to other formats will be 
particularly time-consuming when the captured screen includes the dotted text 
characters often used in screen backgrounds and shading. Each dot in those 
characters must be mathematically calculated and positioned by HiJaak PRO 
during a conversion. To speed the conversion, select Rasterize Text from the 
DOS Capture Options dialog box. This will cause DOSCAP to take a bitmapped 
picture of the objects on your DOS text screen and will eliminate the need for 
much of HiJaak PRO's conversion calculations. 

Q. My DOS text screen capture does not include any peculiar shading 
characters or anything that should hold up the conversion process. Why 
else might conversions from text IGF files take too long?

A. Through the course of revising the text IGF format for this release of HiJaak PRO, 
two separate fonts were created by Inset Systems. The first, IBMPCMED, was 
made available to users of HiJaak for Windows 1.0 to remedy some text screen 
capture problems that had been encountered and was also included in some pre-
release testing of HiJaak PRO Version 2. That font was later replaced by 
IBMPCDOS, a TrueType font. If you are among those users who received 
IBMPCMED, it is possible that the presence of that font is slowing down IGF 
conversions and hurting the quality of those conversions. Check for the presence 
of the font using the Fonts selection under the Windows Control Panel. If you find 
IBMPCMED, remove it using the appropriate Control Panel button. Control Panel 
also provides you the option of deleting the font from your hard drive. We 
suggest you do so. The installation of HiJaak PRO should place the newer 
IBMPCDOS.TTF into your list of available fonts. Using this font, HiJaak PRO will be 
able to give you the best quality conversions of your DOS text screen captures in 
the least time.

Q. How can I avoid a Font File Not Found error message when converting 
from a text screen capture IGF file?

A. That error message should only occur if the font IBMPCDOS.TTF was not properly 
installed into Windows during the HiJaak PRO Setup process. HiJaak PRO uses that
font to depict the characters present in your DOS text screen capture. Using the 
HJSetup icon to run a Workstation install of HiJaak PRO should make the font 
available to Windows. If this doesn't work, re-install HiJaak PRO.

Q. Why do I occasionally see a black line across the top of DOS text screen
captures that have been converted to BMP?

A. A typical DOS text screen capture will show gray text on a black background. In 
converting this screen to BMP and processing it to a black text on white 
background (using the Reverse Black and White option), a black bar may be 
introduced across the top of the image. To achieve the same clean black on white
appearance without the line, you may choose to use the Change a Color 
selection under the Colors selection from the main menu to map the black 
background to white. The gray text may then be mapped to black by the same 



process.



DOSCAP error messages

Q. Why do I get the error message "Card Undefined" when using the 
DOSCAP utility?

A.  You will get the "Card Undefined" error when you have not set up DOSCAP in 
HiJaak PRO.    Pull down the Capture menu and select DOS Capture Options 
(Alt+c, d).    From the Graphics Card area, select the appropriate card type 
(Alt+g, arrow), and try DOSCAP again.

Q: Why do I get the error message Error: Driver or configuration file not 
found. when I try to use DOSCAP?

A: You will see this message if you selected the ATI Ultra Pro graphics card in the 
HiJaak PRO Setup/DOS Capture Options dialog box    because the original release 
of HiJaak PRO 2.0 is missing the file ultrapro.cfg which is used by DOSCAP for the 
ATI Ultra Pro. This file is available on the Inset BBS or the Inset forum on 
Compuserve.



If all else fails... 

...you can use ALTCAP, an alternate DOS capture utility. This utility only works if you 
have a VGA monitor.

Use ALTCAP as follows:
1.    At the HJPRO DOS prompt, type ALTCAP.EXE. ALTCAP will "expand" into the 

following files:
CAPTURE.EXE
HJ02.EXE
VGA.EXE
HJ.SET
FREEALT.COM
ALTCAP.TXT

2.    When you want to capture a DOS screen, either shell out to DOS or exit out of 
Windows.    Switch to the HJPRO directory.

3.    At the DOS prompt, type CAPTURE. You will see a simple instruction screen. Note
that the default hotkeys are Left Shift-Left Ctrl.

WARNING: Do not run DOSCAP at the same time as you run this alternate capture 
procedure.

4. Run the application that has the screen you want to capture, and bring up that 
screen. Press the Left Shift-Left Ctrl keys at the same time.

5. You will see a menu prompting you to select either Screen, or Printer. Use the 
arrow keys to select, and press Enter.

6. You will hear a beep indicating that the Screen has been captured. At the Save 
prompt, type the path and filename where you wish the captured file to be saved.
Press Enter.

7. You will return to the Screen or Printer menu.    When you are through capturing,
press Esc.    Your captured screens will be saved in PIX format in the directory that
you selected.

8. Use HiJaak PRO to convert the *.PIX file to another format.



HiJaak Browser

If you are having problems with HiJaak Browser, click on one of the following for 
more information:

General problems running HiJaak Browser
I can't start HiJaak Browser
Problems copying or moving thumbnails
Thumbnail images do not look right
There's a problem updating some thumbnails



General problems running HiJaak Browser

Q. Why does HiJaak Browser crash as soon as my screen saver kicks in?
A. HiJaak Browser has been tested with the screen saver included with the Windows

3.1 environment. That screen saver may be accessed through the Desktop 
selection of Windows Control Panel. However, testing has shown that other 
screen savers, such as some modules of the popular After Dark program, will 
cause a corruption of data that may crash HiJaak Browser. When using HiJaak 
Browser for an extended update period, it is recommended that only the Windows
screen saver be used.

Q. Why does HiJaak Browser stall or "hang" during an update of image 
thumbnails?

A. It is likely that HiJaak Browser has encountered a problem file. To avoid future 
stalls during thumbnail updates, select the image tile that has been causing 
Browser to hang. Pull down the File menu and select Properties (Alt+f, r). In the
Properties dialog box, click on the Skip Update check box (Alt+s). If it is not 
clear which file is causing the problem, check the HJBROWSE.LOG file found in 
your Windows subdirectory. That log file contains a record of all Browser activity.



I can't start HiJaak Browser

Q. What should I do if HiJaak Browser causes a GPF immediately upon 
startup?

A. HiJaak Browser may cause a General Protection Fault as soon as it is launched if 
it does not fully support your graphics card of display mode. A remedy to this 
problem is to adjust the Browser settings so that it will not rely on device specific 
drawing routines. You can do that by using a text editor, such as Windows 
Notepad,    to open the HJBROWSE.SET file found in your Windows subdirectory 
and add the following line: DIBONLY=ON



Problems copying or moving thumbnails

Q. When I use the File menu to copy or move thumbnails or folders, why 
do the files move but not the thumbnails?

A. When you use the File menu for these operations, you are copying and moving    
only the actual image files. The thumbnails representing those files remain where
they are until you perform an Update on the folder. To move a thumbnail image, 
click on it and drag-drop to the appropriate folder. For more information, click on 
the following:



Thumbnail Images do not look right

Q. Why do thumbnail images appear skewed within HiJaak Browser?
A. HiJaak Browser may not fully support your graphics card or display mode. A 

remedy to this problem is to adjust the Browser settings so that it will not rely on 
device specific drawing routines. You can do that by using a text editor, such as 
Windows Notepad,    to open the HJBROWSE.SET file found in your Windows 
subdirectory and add the following line: DIBONLY=ON

Q: Why don't    the thumbnails I create of my TIFF files look right?
A: If you are using a small 64x64 sized thumbnail of certain images the thumbnails 

may look bad, or even corrupted. If this occurs, change the thumbnail size to 
80x80 and update the image again. The thumbnail should look better.



There's a problem updating some thumbnails

Q. When I select update, HiJaak Browser seems to ignore certain images. 
How can I update those image thumbnails?

A. If HiJaak Browser is unable to read a file during an update, it will skip that 
particular file during subsequent updates. Trying to update just that file will cause
Browser to start the update procedure and then immediately return to the main 
screen. To enable updates of these files, select the image title that has not been 
updated.    Pull down the File menu and select Properties (Alt+f, r). In the 
Properties dialog box, click on the Skip Update check box (Alt+s) to de-select 
it.

Q. Why does HiJaak Browser stall or "hang" during an update of image 
thumbnails?

A. It is likely that HiJaak Browser has encountered a problem file. To avoid future 
stalls during thumbnail updates, select the image tile that has been causing 
Browser to hang. Pull down the File menu and select Properties (Alt+f, r). In the
Properties dialog box, click on the Skip Update check box (Alt+s). If it is not 
clear which file is causing the problem, check the HJBROWSE.LOG file found in 
your Windows subdirectory. That log file contains a record of all Browser activity.

Q: Why does Browser beep when I try to update an image or folder?
A: A beep when you are updating a thumbnail indicates that an error has occurred 

in HiJaak PRO while it was updating the thumbnail for HiJaak Browser. If this 
happens, pull down the HiJaak PRO    Setup menu and select    Load Settings. 
Click on the Defaults button. This will usually fix the problem. 

Try the update again. If loading Defaults does not    fix the problem, resize the 
HiJaak Browser window and HiJaak PRO window so you can view them both side 
by side. The error that is occurring will show up in the HiJaak PRO status bar. Click
on the problem thumbnail and select Update. When Browser issues a beep, note 
the error message on the HJPRO status bar. Then, contact tech support with the 
error message.

 



Import into Other Applications

The topics below gives information on troubleshooting when you are using HiJaak 
PRO with other applications through the application's Place or Insert command, 
HiJaak import filters or OLE. Click on the application below for which you want 
troubleshooting help or tips:

Ami Pro
MS Draw
FreeHand
PageMaker 4.0 and 5.0
Persuasion
PowerPoint
MS Publisher
MS Word for Windows
WordPerfect
Ventura Publisher for Windows

Some problems are not specific to any application, rather, they are related to the 
HiJaak    import filter. For help with this, click on the following:
The HiJaak Import Filter

Note  If you are running Windows in standard mode, you will not be able to import 
image files larger than one megabyte. If you need to import a larger image, try 
running Windows in enhanced mode.



Ami Pro

Q. Why don't HiJaak PRO's import filters come up when I try to insert an 
image into Ami Pro? 

A. The import filters will not work properly immediately after installation of the 
HiJaak PRO package. In order for the import filters to function, HiJaak PRO must 
be run at least once and Windows must be restarted.
 
If the import filters still do not function, check the Ami Pro directory to ensure 
that the HJIMP1.FLT file has been placed there by the HiJaak PRO install program.

Next, check to see that the AMIPRO.INI file, found in the Windows subdirectory, 
contains the following lines. If these lines are missing, the HiJaak PRO has not 
been properly installed. See Chapter 1 of the HiJaak PRO User's Guide for 
instructions on running a Workstation install.

Application43=HJ Amiga ILBM,B,.IFF,hjimp1.flt
Application44=HJ ASCII Text,B,.TXT,hjimp1.flt
Application45=HJ AT&T Group 4,B,.ATT,hjimp1.flt
Application46=HJ AutoCad DXF,B,.DXF,hjimp1.flt
Application47=HJ CALS Raster,B,.CAL,hjimp1.flt
Application48=HJ Compuserve GIF,B,.GIF,hjimp1.flt
Application49=HJ HJ CGM,B,.CGM,hjimp1.flt
Application50=HJ DataBeam,B,.DBX,hjimp1.flt
Application51=HJ Dr. Halo,B,.CUT,hjimp1.flt
Application52=HJ EDMICS,B,.ED5,hjimp1.flt
Application53=HJ GEM MetaFile,B,.GEM,hjimp1.flt
Application54=HJ GEM Paint,B,.IMG,hjimp1.flt
Application55=HJ HP Plotter,B,.PGL,hjimp1.flt
Application56=HJ HP LaserJetII,B,.PCL,hjimp1.flt
Application57=HJ IBM GOCA,B,.GCA,hjimp1.flt
Application58=HJ IBM IOCA,B,.ICA,hjimp1.flt
Application59=HJ Inset IGF,B,.IGF,hjimp1.flt
Application60=HJ Inset PIX,B,.PIX,hjimp1.flt
Application61=HJ JPEG,B,.JPG,hjimp1.flt
Application62=HJ Kofax Group 4,B,.KFX,hjimp1.flt
Application63=HJ Lotus,B,.PIC,hjimp1.flt
Application64=HJ Macintosh PICT,B,.PCT,hjimp1.flt
Application65=HJ MacPaint,B,.MAC,hjimp1.flt
Application66=HJ MicroGraphix,B,.DRW,hjimp1.flt
Application67=HJ Microsoft MSP,B,.MSP,hjimp1.flt
Application68=HJ PC Paintbrush,B,.PCX,hjimp1.flt
Application69=HJ PhotoCD,B,.PCD,hjimp1.flt
Application70=HJ StoryBoard PIC,B,.PCB,hjimp1.flt
Application71=HJ Sun Raster,B,.RAS,hjimp1.flt
Application72=HJ TIFF,B,.TIF,hjimp1.flt
Application73=HJ Targa,B,.TGA,hjimp1.flt
Application74=HJ Wicat,B,.GED,hjimp1.flt
Application75=HJ Windows Icon,B,.ICO,hjimp1.flt



Application76=HJ WMF,B,.WMF,hjimp1.flt
Application77=HJ Windows OS2,B,.BMP,hjimp1.flt
Application78=HJ Windows OS2,B,.RLE,hjimp1.flt
Application79=HJ WordPerfect,B,.WPG,hjimp1.flt
Application80=HJ Windows CLP,B,.CLP,hjimp1.flt
Application81=HJ Knowledge CPR,B,.CPR,hjimp1.flt
Application82=HJ Viewable EPS,B,.EPS,hjimp1.flt
Application83=HJ Tektronix P10,B,.P10,hjimp1.flt
Application84=HJ Fax Type,B,.FAX,hjimp1.flt

If the lines are correct and the HiJaak import still won't function properly, try adding 
the path to the HiJaak PRO filter to each of the application lines in the AMIPRO.INI 
file. For example:

Change Application43=HJ Amiga ILBM,B,.IFF,hjimp1.flt
To Application43=HJ Amiga ILBM,B,.IFF,c:\amipro=hjimp1.flt



Microsoft Draw

Q. Why has the install of HiJaak PRO caused me to be unable to access 
Microsoft Draw?

A. Early versions of Microsoft Draw, a drawing/painting package that is part of 
Microsoft Publisher and Microsoft Word for Windows, have a fixed limit on the 
number of graphics import filters they may support. After installing HiJaak PRO's 
import filters for Microsoft Publisher and/or Word for Windows, there will be more 
filters than Draw can handle. Deleting HiJaak import filters from the MS Import 
section of the WIN.INI file in your Windows directory will resolve the problem. This
difficulty should not occur with the more recent version of Draw packaged with 
the Microsoft Word for Windows 2.0a.



FreeHand

Q. Why don't HiJaak PRO's import filters come up when I try to place an 
image into FreeHand? 

A. The import filters will not work properly immediately after installation of the 
HiJaak PRO package. In order for the import filters to function, HiJaak PRO must 
be run at least once and Windows must be restarted.
If the import filters are still not functioning, check the [Aldus Imports] section of
your ALDUS.INI file to see if the appropriate lines have been placed there by the 
import filter install. To see the full list, click on the following:
Aldus Imports

If the lines are all present, but the import filter still will not work, add the path to 
your HiJaak import filter onto the filter statements in your ALDUS.INI file. For 
example:

Change: HJ Amiga ILBM=hjimp2.flt,IFF
To: HJ Amiga ILBM=c:\aldus\usenglsh\filters\hjimp2.flt,IFF

The location of the Aldus files can be determined by reading the [Aldus] section 
of the WIN.INI file in your Windows subdirectory.

Q. After the HiJaak import filters are installed, I have more import filters 
than FreeHand can use. How can I remove the filters that I will not be 
using?

A. To remove some of the import filters available to FreeHand, run the ALDSETUP 
program and select FH3720.CTL. Choose Aldus Product Filters and click on 
the Setup button. At the error message, click on Continue. You will then be able 
to select the filters you wish to remove. Pressing OK will exit the setup program.

Q. What is the cause of a blank image produced by using HiJaak's import 
filters?

A. If the import seems to be progressing normally but results in a blank box being 
imported into your application, the cause may be a memory limitation in 
Windows' standard mode. Larger images may require more memory than 
standard mode Windows can allocate at one time and so may come in blank. Run 
Windows in enhanced mode to resolve this problem.



PageMaker 4.0 and 5.0

Q. Why have I noticed a reduction in the quality of the 24-bit color images 
that I have brought into PageMaker 4.0 through the HiJaak Import 
Filters?

A. Placing 24-bit color images into PageMaker 4 through an import filter is a very 
time-consuming process. To get the best quality within a reasonable amount of 
time, HiJaak PRO has been designed to reduce 24-bit images to 8-bit with the 
Diffuse color reduction method during import into PageMaker. This will produce 
excellent results in most cases. Where genuine 24-bit images are desired, it is 
suggested that a HiJaak PRO conversion of the source image to a 24-bit TIFF be 
performed with that image subsequently being placed into PageMaker 4. HiJaak 
PRO import filters are bypassed during placement of TIFF images, as that format 
is supported internally within PageMaker.

Q. Screen captures brought into PageMaker as TIFF images sometimes 
come in with black and white reversed. What can I do to fix the image?

A. Selecting Image Control under PageMaker's Element menu will allow for 
brightness and contrast and other adjustments to your placed image. Selecting a 
contrast of -50 will reverse black and white in your image.

Q. Why do my images look bad when brought into PageMaker 4.0?
A. On-screen image quality is controlled in PageMaker through the Edit menu's 

Preferences selection. The best on-screen quality will be achieved when the 
Detailed Graphics option is set to High Resolution. Still, images may appear 
to be missing details when viewed from within PageMaker. However, this is 
merely the result of PageMaker's on-screen presentation of an image rather than 
a deficiency in the image itself. All details should be seen when the image is 
finally printed from PageMaker.

Q. Why don't HiJaak PRO's import filters come up when I try to place an 
image into PageMaker 4.0? 

A. The import filters will not work properly immediately after installation of the 
HiJaak PRO program. In order for the import filters to function, HiJaak PRO must 
be run at least once and Windows must be restarted.
If the import filters are still not functioning, check the [Aldus Imports] section of
your ALDUS.INI file to see if the appropriate lines have been placed there by the 
import filter install. To see the full list, click on the following:
Aldus Imports

If the lines are all present, but the import filter still will not work, add the path to 
your HiJaak import filter onto the filter statements in your ALDUS.INI file. For 
example:

Change: HJ Amiga ILBM=hjimp2.flt,IFF
To: HJ Amiga ILBM=c:\aldus\usenglsh\filters\hjimp2.flt,IFF

The location of the Aldus files can be determined by reading the [Aldus] section 
of the WIN.INI file in your Windows subdirectory.



Q. Why won't PageMaker 4.0 use HiJaak's import filters when placing an 
image?

A. Both PageMaker 4.0 and Persuasion will use external import filters in the order 
they are listed in the ALDUS.INI file. If there were previous filters installed for 
certain formats -- CGM, for example -- and HiJaak PRO's import filters are then 
installed, those applications will continue to use the previous import filters 
because they are placed earlier in the ALDUS.INI file. To ensure that the HiJaak 
import filters are used, the other filters must be de-installed using the ALDSETUP 
utility or the lines referring to those filters must be removed from the ALDUS.INI 
file.

Q. Why don't HiJaak PRO's import filters come up when I try to place an 
image into PageMaker 5.0? 

A. The import filters will not work properly immediately after installation of the 
HiJaak PRO package. In order for the import filters to function, HiJaak PRO must 
be run at least once and Windows must be restarted.
If the import filters for PageMaker 5.0 are still not functioning, check the filters 
subdirectory (typically it would be C:\ALDEO\USENGLSH\FILTERS) to see if the 
HJIMP2.P5F has been placed there by the HiJaak PRO install. If the file cannot be 
found in that subdirectory, re-run the HiJaak PRO install program to install import 
filters and select PageMaker 5.0 from the list of applications.

Q. I've copied or cut an image from HiJaak PRO into the Windows 
Clipboard. Now, how do I paste that image into PageMaker 5.0?

A. The Beta version of PageMaker 5.0 that was tested with this release of HiJaak 
PRO would only properly paste vector graphics if Paste Special was selected 
from under the Edit menu. Raster images would paste properly only when the 
Paste Link option was selected.



Persuasion

Q. Why don't HiJaak PRO's import filters come up when I try to place an 
image into Persuasion? 

A. The import filters will not work properly immediately after installation of the 
HiJaak PRO program. In order for the import filters to function, HiJaak PRO must 
be run at least once and Windows must be restarted.
If the import filters are still not functioning, check the [Aldus Imports] section of
your ALDUS.INI file to see if the appropriate lines have been placed there by the 
import filter install. To see the full list, click on the following:
Aldus Imports

If the lines are all present, but the import filter still will not work, add the path to 
your HiJaak import filter onto the filter statements in your ALDUS.INI file. For 
example:

Change: HJ Amiga ILBM=hjimp2.flt,IFF
To: HJ Amiga ILBM=c:\aldus\usenglsh\filters\hjimp2.flt,IFF

The location of the Aldus files can be determined by reading the [Aldus] section 
of the WIN.INI file in your Windows subdirectory.

Q. Why won't Persuasion use HiJaak's import filters when placing an 
image?

A. Both PageMaker 4.0 and Persuasion will use external import filters in the order 
they are listed in the ALDUS.INI file. If there were previous filters installed for 
certain formats -- CGM, for example -- and HiJaak PRO's import filters are then 
installed, those applications will continue to use the previous import filters 
because they are placed earlier in the ALDUS.INI file. To ensure that the HiJaak 
import filters are used, the other filters must be de-installed using the ALDSETUP 
utility or the lines referring to those filters must be removed from the ALDUS.INI 
file.



Aldus Imports

The following is a list of lines that should appear in the [Aldus Imports] section of 
your ALDUS.INI in order for the HiJaak import filters to work properly with 
PageMaker, FreeHand and Persuasion.

HJ Amiga ILBM=hjimp2.flt,IFF
HJ ASCII Text=hjimp2.flt,TXT
HJ AT&T Group 4=hjimp2.flt,ATT
HJ AutoCad DXF=hjimp2.flt,DXF
HJ CALS Raster=hjimp2.flt,CAL
HJ Compuserve GIF=hjimp2.flt,GIF
HJ HJ CGM=hjimp2.flt,CGM
HJ DataBeam=hjimp2.flt,DBX
HJ Dr. Halo=hjimp2.flt,CUT
HJ EDMICS=hjimp2.flt,ED5
HJ GEM MetaFile=hjimp2.flt,GEM
HJ GEM Paint=hjimp2.flt,IMG
HJ HP Plotter=hjimp2.flt,PGL
HJ HP LaserJetII=hjimp2.flt,PCL
HJ IBM GOCA=hjimp2.flt,GCA
HJ IBM IOCA=hjimp2.flt,ICA
HJ Inset IGF=hjimp2.flt,IGF
HJ Inset PIX=hjimp2.flt,PIX
HJ JPEG=hjimp2.flt,JPG
HJ Kofax Group 4=hjimp2.flt,KFX
HJ Lotus=hjimp2.flt,PIC
HJ Macintosh PICT=hjimp2.flt,PCT
HJ MacPaint=hjimp2.flt,MAC
HJ MicroGraphix=hjimp2.flt,DRW
HJ Microsoft MSP=hjimp2.flt,MSP
HJ PC Paintbrush=hjimp2.flt,PCX
HJ PhotoCD=hjimp2.flt,PCD
HJ StoryBoard PIC=hjimp2.flt,PCB
HJ Sun Raster=hjimp2.flt,RAS
HJ Targa=hjimp2.flt,TGA
HJ Wicat=hjimp2.flt,GED
HJ Windows Icon=hjimp2.flt,ICO
HJ WMF=hjimp2.flt,WMF
HJ Windows OS2=hjimp2.flt,DIB
HJ WordPerfect=hjimp2.flt,WPG
HJ Windows CLP=hjimp2.flt,CLP
HJ Knowledge CPR=hjimp2.flt,CPR
HJ Tektronix P10=hjimp2.flt,P10
HJ Fax Type=hjimp2.flt,FAX



PowerPoint

Q. Why don't HiJaak PRO's import filters come up when I try to place an 
image into PowerPoint? 

A. The import filters will not work properly immediately after installation of the 
HiJaak PRO program. In order for the import filters to function, HiJaak PRO must 
be run at least once and Windows must be restarted.
If the import filters still do not function, check the HiJaak PRO directory (typically 
C:\HJPRO) to ensure that the HJIMP1.FLT file has been placed there by the HiJaak 
PRO install program.
Next, check to see if    the appropriate lines have been added to the 
POWERPNT.INI file, found in the PowerPoint subdirectory. To see the full list, click 
on the following:
MS Graphic Import Filters 



MS Publisher

Q. Why has the install of HiJaak PRO caused me to be unable to access 
Microsoft Draw?

A. Early versions of Microsoft Draw, a drawing/painting package that is part of 
Microsoft Publisher and Microsoft Word for Windows, have a fixed limit on the 
number of graphics import filters they may support. After installing HiJaak PRO's 
import filters for Microsoft Publisher and/or Word for Windows, there will be more 
filters than Draw can handle. Deleting HiJaak import filters from the MS Import 
section of the WIN.INI file in your Windows directory will resolve the problem. This
difficulty should not occur with the more recent version of Draw packaged with 
the Microsoft Word for Windows 2.0a.



Word for Windows

Q. Why has the install of HiJaak PRO caused me to be unable to access 
Microsoft Draw?

A. Early versions of Microsoft Draw, a drawing/painting package that is part of 
Microsoft Publisher and Microsoft Word for Windows, have a fixed limit on the 
number of graphics import filters they may support. After installing HiJaak PRO's 
import filters for Microsoft Publisher and/or Word for Windows, there will be more 
filters than Draw can handle. Deleting HiJaak import filters from the MS Import 
section of the WIN.INI file in your Windows directory will resolve the problem. This
difficulty should not occur with the more recent version of Draw packaged with 
the Microsoft Word for Windows 2.0a.

Q. What raster format will give me the best results in Word for Windows?
A. The best raster format to use with Word for Windows is TIFF. Generally, to find 

the format that will work best in a particular application just click on the 
Applications button in the Save As... or Convert To... dialog box. Select the 
appropriate destination application from the applications list, and HiJaak PRO will 
automatically select the best format for that application.

Q. Why has the install of HiJaak PRO caused me to be unable to access 
Microsoft Draw?

A. Early versions of Microsoft Draw, a drawing/painting package that is part of 
Microsoft Publisher and Microsoft Word for Windows, have a fixed limit on the 
number of graphics import filters they may support. After installing HiJaak PRO's 
import filters for Microsoft Publisher and/or Word for Windows, there will be more 
filters than Draw can handle. Deleting HiJaak import filters from the MS Import 
section of the WIN.INI file in your Windows directory will resolve the problem. This
difficulty should not occur with the more recent version of Draw packaged with 
the Microsoft Word for Windows 2.0a.

Q. Why does Word for Windows use its own graphics import filters instead 
of the HiJaak import filters I have installed?

A. In cases where Word for Windows and HiJaak PRO support the import of the same
file formats, Word for Windows prefers to use its own filters. To force Word for 
Windows to use the HiJaak import filters instead, you must edit the WIN.INI file in 
your Windows subdirectory and remove or "comment out" the appropriate 
Microsoft graphics import lines.    You can comment out these lines by adding a 
semi-colon ; or a pound sign to # to the beginning of the line.

Q. Why don't HiJaak PRO's import filters come up when I try to place an 
image into Word for Windows? 

A. The import filters will not work properly immediately after installation of the 
HiJaak PRO program. In order for the import filters to function, HiJaak PRO must 
be run at least once and Windows must be restarted.
If the import filters still do not function, check the HiJaak PRO directory (typically 
C:\HJPRO) to ensure that the HJIMP1.FLT file has been placed there by the HiJaak 
PRO install program.
Next, check to see if    the appropriate lines have been added to the [MS Graphic 



Import Filters] section of the WIN.INI file, found in the Windows subdirectory. To 
see the full list, click on the following:
MS Graphic Import Filters 



MS Graphic Import Filters

The following is a list of lines that should appear in your WIN.INI and POWERPNT.INI 
files in order for the HiJaak import filters to work properly with Word for Windows 
and PowerPoint.    This list assumes HiJaak PRO was installed in C:\HJPRO. If you 
installed in another directory, replace this path with your path.

HJ Amiga ILBM=C:\hjpro\hjimp1.flt,IFF
HJ ASCII Text=C:\hjpro\hjimp1.flt,TXT
HJ AT&T Group 4=C:\hjpro\hjimp1.flt,ATT
HJ AutoCad DXF=C:\hjpro\hjimp1.flt,DXF
HJ CALS Raster=C:\hjpro\hjimp1.flt,CAL
HJ Compuserve GIF=C:\hjpro\hjimp1.flt,GIF
HJ HJ CGM=C:\hjpro\hjimp1.flt,CGM
HJ DataBeam=C:\hjpro\hjimp1.flt,DBX
HJ Dr. Halo=C:\hjpro\hjimp1.flt,CUT
HJ EDMICS=C:\hjpro\hjimp1.flt,ED5
HJ GEM MetaFile=C:\hjpro\hjimp1.flt,GEM
HJ GEM Paint=C:\hjpro\hjimp1.flt,IMG
HJ HP Plotter=C:\hjpro\hjimp1.flt,PGL
HJ HP LaserJetII=C:\hjpro\hjimp1.flt,PCL
HJ IBM GOCA=C:\hjpro\hjimp1.flt,GCA
HJ IBM IOCA=C:\hjpro\hjimp1.flt,ICA
HJ Inset IGF=C:\hjpro\hjimp1.flt,IGF
HJ Inset PIX=C:\hjpro\hjimp1.flt,PIX
HJ JPEG=C:\hjpro\hjimp1.flt,JPG
HJ Kofax Group 4=C:\hjpro\hjimp1.flt,KFX
HJ Lotus=C:\hjpro\hjimp1.flt,PIC
HJ Macintosh PICT=C:\hjpro\hjimp1.flt,PCT
HJ MacPaint=C:\hjpro\hjimp1.flt,MAC
HJ MicroGraphix=C:\hjpro\hjimp1.flt,DRW
HJ Microsoft MSP=C:\hjpro\hjimp1.flt,MSP
HJ PC Paintbrush=C:\hjpro\hjimp1.flt,PCX
HJ PhotoCD=C:\hjpro\hjimp1.flt,PCD
HJ StoryBoard PIC=C:\hjpro\hjimp1.flt,PCB
HJ Sun Raster=C:\hjpro\hjimp1.flt,RAS
HJ TIFF=C:\hjpro\hjimp1.flt,TIF
HJ Targa=C:\hjpro\hjimp1.flt,TGA
HJ Wicat=C:\hjpro\hjimp1.flt,GED
HJ Windows Icon=C:\hjpro\hjimp1.flt,ICO
HJ WMF=C:\hjpro\hjimp1.flt,WMF
HJ Windows OS2=C:\hjpro\hjimp1.flt,DIB
HJ WordPerfect=C:\hjpro\hjimp1.flt,WPG
HJ Windows CLP=c:\hjpro\hjimp1.flt,CLP
HJ Knowledge CPR=c:\hjpro\hjimp1.flt,CPR
HJ Viewable EPS=c:\hjpro\hjimp1.flt,EPS
HJ Tektronix P10=c:\hjpro\hjimp1.flt,P10
HJ Fax Type=c:\hjpro\hjimp1.flt,FAX



WordPerfect 

Q. How can I get the best grayscale printed output of my images from 
within WordPerfect?

A. On a 300 dpi printer, the best output will be achieved from WordPerfect by using 
HiJaak PRO to convert the source file to TIFF/WordPerfect flavor with the following 
options: horizontal and vertical resolutions of 300; width and/or height equal to 
the desired dimensions of the printed image; Number of Colors set to Black 
and White; Reduction Method set to Halftone; Screen Frequency set 
between 75 and 90. The TIFF image should then be brought into WordPerfect at 
precisely the width and/or height indicated in the HiJaak PRO options. The image 
may display poorly in WordPerfect due to the patterns present in the halftone, but
it will print well.

Q. How can I achieve the best black and white printed output of my text 
screen captures in WordPerfect?

A. The best results will be achieved by converting your text screen capture to the 
WPG vector format with the All Colors to Black option. No sizing options need 
to be selected for this vector conversion. The image may be scaled to the 
appropriate size within WordPerfect.

Q. Why do my image colors or tones appear incorrect when my image is 
viewed in WordPerfect?

A. WordPerfect has the ability to invert image palettes. When correct palettes are 
inverted, image colors and tones will be wrong. To correct the problem, view the 
image in WordPerfect's Edit mode and select 4 for Invert On/Off.

Q. HiJaak PRO does not properly import an image into WordPerfect for 
Windows using the HiJaak Retrieve Macro. What should I do?

A. Check to see that the HiJaak Import lines shown below have been added to the 
[MacroMenuList] section of the WPWP.INI file found in the Windows subdirectory.

HiJaak Import (FILE)=c:\hjpro\hjimport.wcm
HiJaak Import (CLIPBOARD)=c:\hjpro\hjimport.wcm

Note that WordPerfect for Windows may have a maximum of 10 installed macros 
in the WPWP.INI file.



Ventura Publisher for Windows

Q. How can I achieve the best results printing DOS screen captures from 
Ventura Publisher to my PostScript language printer?

A. Whenever possible, changing colors from dithered colors to solids will improve 
the quality of an image. Then, a conversion to EPS with Brightness set to 15 
should produce the best printed output from Ventura to your PostScript language 
printer.

Q. Why does HiJaak PRO produce only a grayscale flavor of TIFF for 
Ventura Publisher?

A. Grayscale TIFF generally produces better results in Ventura Publisher. For that 
reason the selection of the Ventura flavor in the TIFF Options dialog box 
produces only grayscale TIFF. Ventura Publisher is capable of displaying and 
printing up to 24-bit color TIFF files, however, the display may not look as you 
expect it to even though it should print correctly. You can use HiJaak PRO to 
create a color TIFF that will work in Ventura, by setting the TIFF Flavor option to 
PC Paintbrush.



 The HiJaak import filters

Q. Why do the images I place in my applications through HiJaak's import 
filters always look the same size?

A. HiJaak PRO does allow for scaling of images brought through the import filters. 
However, a set frame size is usually assigned for images brought through the 
filters. To get the best printed results, it is important to stretch the image frame 
to be the same size as the dimensions given to HiJaak PRO during the import 
process. For example, if a JPG image was sized to 5 inches wide and a resolution 
of 300 dots per inch when it was imported into Pagemaker, it might show up in 
Pagemaker as only a 2-inch-wide image. Click on the image to produce frame 
"handles," and drag the handles until the image is exactly 5 inches in width to 
produce the best print quality.

Q. What is the cause of a blank image produced by using HiJaak's import 
filters?

A. If the import seems to be progressing normally but results in a blank box being 
imported into your application, the cause may be a memory limitation in 
Windows' standard mode. Larger images may require more memory than 
standard mode Windows can allocate at one time and so may come in blank. Run 
Windows in enhanced mode to resolve this problem.

Q. How can I use the HiJaak import filters to bring a fax file into my 
application?

A. In order to import fax files through the HiJaak import filters, the appropriate INI 
file for the receiving application must be edited in a text editor (MS-DOS Edit 
program or Windows Notepad). 
(For Aldus PageMaker 4.0, FreeHand and Persuasion, the appropriate INI file is the
ALDUS.INI file in the \ALDUS\USENGLSH subdirectory. For Microsoft PowerPoint, 
the appropriate INI file is the POWERPNT.INI file in the PowerPoint subdirectory. 
For Word for Windows, the appropriate INI file is the WIN.INI file in the Windows 
subdirectory. For Lotus Ami Pro, the appropriate INI file is the AMIPRO.INI file in 
the Windows subdirectory.)

Locate the HJ Fax Type filter line in the INI file and change that according to the 
fax card used. See the table below for the correct fax name and file extension:

Fax Card Ext. Fax Card Ext.
AdTech F01 Hayes JT Fax 001
Brooktrout Fax-
Mail

301 JetFax FFF

Calculus EZ-Fax 001 Intel DCX
Complete FAX 
Portable

001 Net Fax Manager OAZ

Complete FAX 001 Product R&D Fax 
Modem

F01

Everex EFAX 2 FAX Relisys TEFAX FAX
Everex EFAX 3 FAX Ricoh 001
Faxable PCX FCX SciFAX    SCI
Faxable TIFF FTF SMARTFAX 001



Frecom FAX96 FAX SpectraFAX DCX
Fujitsu dexNET 001 TriGem F01
GammaLink TIF WorldPort 001
Generic Fax FAX Xerox MicroFax FAX

Substitute the fax card name for "Fax Type" in the HiJaak import line, and 
substitute the correct extension (shown above) for the "FAX" at the end of the 
HiJaak import line as shown:

Change: HJ Fax Type=c:\hjpro\hjimp1.flt,FAX
To: HJ Intel Fax=c:\hjpro\hjimp1.flt,DCX



Networks

Q. How can I get HiJaak PRO to work properly with Novell Netware 4.0?
A. HiJaak PRO's network installation is currently incompatible with Novell Netware 

4.0. Contact Inset Systems technical support for a resolution to this problem.



Opening

Q: Why does HiJaak PRO GPF when I click on File / Open?
A: If HiJaak PRO finds outdated DLLs in the WINDOWS\SYSTEM directory, this might 

happen. These older DLLs appear because some applications copy older DLLs 
into the WINDOWS\SYSTEM directory. To solve this problem, exit Windows and 
switch to the    WINDOWS\SYSTEM directory.
Type your path to HJPRO, followed by \REDIST.EXE -o. For example, if you have 
not changed the default install directory for HiJaak PRO, you would type:

C:\HJPRO\REDIST.EXE -o
This will copy the latest DLLs into your system directory and should solve the 
problem.



Printing

For tips on getting better results printing, click on one of the following:

Black and white print-outs of color images
General printing tips
Printing from your applications
Printing errors



General printing tips

Q. What can I do about problems that surface when printing from HiJaak 
PRO to an HP DeskJet 500C?

A. The version 2.1 printer driver that was shipped with many DeskJet 500C printers 
may run into some problems. According to Hewlett Packard technical support, the
2.1 driver has had some problems clearing memory after it is used. That presents
problems for subsequent uses of the driver. The most common instance of that 
driver defect interfering with HiJaak PRO print jobs occurs when a HiJaak PRO 
print is canceled. After canceling the print job, the 2.1 driver does not clear itself 
from memory and additional printing to the DeskJet 500C during that Windows 
session is impossible. HP does now provide a new driver -- Version 3 -- that does 
not have the same problems as its predecessor. That driver is available through 
CompuServe or direct from HP.

Q. How can I improve the print quality of vector images that contain 
rotated text?

A. Rotated text within vector images is sometimes placed incorrectly in HiJaak PRO 
printouts. To ensure that the text will print properly, select Print TrueType Fonts
as Graphics in the setup screen for your printer.

Q. What scaling options should be used on my image to ensure the best 
quality printing?

A. When scaling an image for printing, select horizontal and vertical resolutions that
match those of your print device. If the image was to be printed on a typical laser
printer, for example, the resolutions should be set to 300. After setting the 
appropriate resolutions, the width and height fields should be filled in with the 
dimensions desired in the printed output. Selecting Maintain Aspect Ratio will 
ensure that the proportions of the original image are preserved while the image is
being scaled.



Printing from your applications

WORDPERFECT:
Q. How can I get the best grayscale printed output of my images from 

within WordPerfect?
A. On a 300 dpi printer, the best output will be achieved from WordPerfect by using 

HiJaak PRO to convert the source file to TIFF/WordPerfect flavor with the following 
options: horizontal and vertical resolutions of 300; width and/or height equal to 
the desired dimensions of the printed image; Number of Colors set to Black 
and White; Reduction Method set to Halftone; Screen Frequency set 
between 75 and 90. The TIFF image should then be brought into WordPerfect at 
precisely the width and/or height indicated in the HiJaak PRO options. The image 
may display poorly in WordPerfect due to the patterns present in the halftone, but
it will print out well.

Q. How can I achieve the best black and white printed output of my text 
screen captures in WordPerfect?

A. The best results will be achieved by converting your text screen capture to the 
WPG vector format with the All Colors to Black option. No sizing options need 
to be selected for this vector conversion. The image may be scaled to the 
appropriate size within WordPerfect.

VENTURA PUBLISHER:
Q. How can I achieve the best results printing DOS screen captures from 

Ventura Publisher to my PostScript language printer?
A. Whenever possible, changing colors from dithered colors to solids will improve 

the quality of an image. Then, a conversion to EPS with Brightness set to 15 
should produce the best printed output from Ventura to your PostScript language 
printer.



Printing Errors

Q: Why do I get a blank page when I print from HiJaak PRO?
A: This error might occur if your set file has been corrupted somehow. When this 

occurs, close the image you are trying to print and reload the default set file by 
pulling down the    Setup menu and selecting Load Settings. In the Load 
Settings dialog box, click on the Defaults button. If this does not correct this 
problem, contact Inset technical support.



Scaling and Resizing

For tips on scaling and resizing your images, click on one of the following:

Changing the size of an image
Preventing distortion while scaling or resizing
Getting the best print-outs when scaling
Scaling the view



Changing the size of an image

Q. How can I scale an image to be two or three times the size of the 
original?

A. HiJaak PRO allows for this type of scaling through the Multiples selection under 
Units in the Resize dialog box. Once Multiples is set as the unit of scaling, the 
image will be scaled a number of times equal to the values placed in the width 
and height fields. For example, entering 2 in the width field and 2 in the height 
field will produce an image that is double the size of the original.

Q. How can I size an image to match the dimensions of my screen?
A. Selecting Fit in Display Width from the Resize dialog box will scale your image

to be precisely as wide as your display screen. It will preserve the proportions of 
your original image. Selecting Fit in Display will scale your image to be 
precisely as wide and as tall as your display screen. If necessary, this scaling 
option will distort the width to height proportion of the original image.



Preventing distortion while scaling or resizing

Q. How can I prevent stretching or squashing of my image when I resize it?
A. Stretching or squashing of an image may occur when the height and width 

values entered by the user are not in the same proportion as the width and 
height of the original. The Maintain Aspect Ratio selection on HiJaak PRO's 
Resize dialog box ensures that the proportions of the original image are 
preserved during scaling.



Getting the best print-outs when scaling

Q. What scaling options should be used on my image to ensure the best 
quality printing?

A. When scaling an image for printing, select horizontal and vertical resolutions that
match those of your print device. If the image was to be printed on a typical laser
printer, for example, the resolutions should be set to 300. After setting the 
appropriate resolutions, the width and height fields should be filled in with the 
dimensions desired in the printed output. Selecting Maintain Aspect Ratio will 
ensure that the proportions of the original image are preserved while the image is
being scaled.



Scaling the view

Q. Why do the scaling options "Page in Width" and "Scale to Window" not 
work with DOS text screen captured IGF images?

A. Due to limitations inherent in the rendering of Windows TrueType fonts, HiJaak 
PRO does not support the use of those scaling options for text screen IGF files.



Text and Fonts

For advice on dealing with known problem areas related to text and fonts, click on 
one of the following:

Change a Font is not working properly
How can I change text and fonts in DOS text screen captures
I'm having problems with fonts in my PCL files
Text in my ASCII TXT file looks wrong



Change a Font is not working properly

Q. Why is my text not resizing to where I drag the selected text handles 
when using the Change a Font option from the Edit menu?

A. In order to maintain readability, Windows 3.1 snaps the font size to a given size 
closest to your specification.    This is primarily a function of Windows 3.1 and will 
be only slightly larger or smaller than your specification. Note that if you change 
font size in CGM files, only height is taken into account.    That is, if you change 
height of the font, the width will change to maintain aspect ratio; if you change 
the width, nothing will happen.

Q. Why isn't my text file viewing properly in HiJaak PRO?
A. When viewing a 132 column mode text file, you must use the Change a Font 

option from the Edit menu to select the text and scale it down to fit on the 
screen.



How can I change text and fonts in my DOS text screen capture?

Q. How can I change fonts in a DOS text screen capture?
A. HiJaak PRO does not currently permit the changing of fonts in a DOS text screen 

capture. In order to change the font, convert the image to the TXT format first. 
Font changes will be possible for the converted image file.



I'm having problems with fonts in my PCL files

Q. Why does my PCL image have incorrect fonts? What does the Font File 
Not Found error message mean?

A. A PCL 4 file, such as those supported by HiJaak PRO, generally contains all 
information that a LaserJet II compatible printer will require for accurate printing 
and will show up with correct fonts in HiJaak PRO. However, some applications 
keep important font information separate from the document information. Those 
applications will produce incomplete PCL files that will probably not function as 
expected in HiJaak PRO and may cause a Font File Not Found error message 
during conversion. For these PCL files to function properly, it is important to enter
the Source PCL Options screen at the beginning of a PCL conversion and 
download the appropriate font files into HiJaak PRO. It is important to note that 
downloading of fonts into HiJaak PRO will usually not be required for a successful 
PCL conversion as fonts are typically included in the PCL file itself.

Q. Why does a "Font File Not Found" error message appear when I attempt
to open a valid PCL 4 file into HiJaak PRO?

A. Even when the PCL file is valid and contains all necessary font information, 
HiJaak PRO may generate a font error message if the PCL interpreter files were 
not installed with the rest of the product. This would most likely be the result of a 
Custom Install, in which the HP PCL 4 Interpretation option was not selected.
To enable conversion of PCL files, reinstall HiJaak PRO using Full Install or be 
certain to select the HP PCL 4 Interpretation option in the Custom Install.

Q. What can I do to avoid conversion failures and missing characters when
converting from a PCL file?

A. Previously stored font information may prevent HiJaak PRO from successfully 
converting a source PCL file. A RESETPCL.BAT utility, installed in the HJPRO 
directory, allows for the clearing of old font information. To use the utility, exit 
HiJaak PRO and run RESETPCL with the path to your Windows directory (typically, 
C:\WINDOWS) as the command line parameter.
You can also fix this problem by opening the Printers selection in the Windows 
Control Panel. Click on the Use Print Manager check box (Alt+u) to disable the 
Windows Print Manager.

Q. How can I avoid the change in font that occurs when I rotate my PCL 
file?

A. The PCL4 used by HiJaak PRO in emulation of the LaserJet II does not provide for 
the rotation of fonts. HiJaak PRO substitutes an already-rotated font whenever 
text in a PCL file is rotated. That may cause the look of the PCL file to change. To 
avoid the change in font, convert the PCL file to PCX and then back to PCL. The 
conversion through PCX will cause text to become bitmapped representations of 
the original font. Subsequent rotation of the PCL file will not change the 
appearance of the text.



Text in my ASCII TXT file looks wrong

Q. When I am viewing an ASCII TXT file, the font in my TXT file is incorrect 
and extends beyond the border of the window.    How do I correct this?

A. Your set file has probably been corrupted.    Pull down the Setup menu and select
Load Settings.    In the Load Settings dialog box, click on Defaults.    Click on 
OK.    Re-start HiJaak PRO and open your TXT file again.

If this doesn't work, check in the Windows Control Panel Font utility to make sure 
you have TrueType fonts enabled.    If they were not, enable them and try again.

If this doesn't work, then the IBMPCDOS font that HiJaak PRO expects to read has 
probably been deleted from your HJPRO directory.    Double-click on the HJSetup 
icon and run a Workstation install to re-add that font, and try again. If that 
doesn't work, you will have to re-install HiJaak PRO.



TWAIN

For advice on problems with HiJaak PRO's TWAIN support, click on one of the 
following:

TWAIN doesn't work at all
I can't get TWAIN to work with my Nisca Spectra scanner



TWAIN doesn't work at all

Q. Why are HiJaak PRO's TWAIN Select Source and Acquire options grayed 
out?

A. Those options, found under the File menu selection, will be grayed out if you do 
not have any TWAIN devices (scanners supporting the TWAIN protocol) installed. 
The installation procedure for TWAIN devices make certain device drivers, files 
with .DS extensions, available to Windows and enable the selection of the Select 
Source and Acquire options.

Q. Why doesn't TWAIN work on my computer system?
A. Some TWAIN device drivers will make use only of conventional memory. If there 

is not enough conventional memory available, TWAIN will not function. 
Eliminating other device drivers and TSRs, programs that load into memory and 
stay there waiting to be activated, will free up some additional conventional 
memory.



I can't get TWAIN to work with my Nisca Spectra scanner

Q. How can I troubleshoot TWAIN problems that I am having with my Nisca
Spectra scanner?

A. In general, it would be best to refer all difficulties related to the scanner to its 
manufacturer. However, during testing of HiJaak PRO the answers to some 
common problems were discovered:
"Cannot read from device HH$SCAN" indicates that the device driver for your
scanner has not been loaded or that you have configured it for a serial port that 
is not available on your computer system. This error message may also be the 
result of setting the device driver to run at too high a baud rate.
"Can't get data from scanner: couldn't allocate secondary scan buffer" 
indicates that there is insufficient conventional memory available. Free additional
memory by eliminating running programs, other device drivers or TSRs, 
programs that load into memory and stay there waiting to be activated.
"Couldn't initiate scan. Reduce scanning speed" indicates that the scan 
dimensions are in an indeterminate state. To correct the problem, set the 
dimensions to 4.0 inches by 6.0 inches in the Nisca Acquire Source dialog box.
Use the mouse to drag the image display frame to those exact dimensions. After 
initializing the scan image display frame in this manner, the frame can be 
successfully adjusted to the size you wish.



Windows Capture

For advice on problems with Windows Capture, see below:

I can't capture it...
My Windows capture doesn't look right



I can't capture it...

Q. Why am I unable to capture my application's pull-down menu with 
HiJaak PRO?    Every time I hit the hot-keys to capture an area, the menu 
goes away.

A. When capturing a pull-down menu with HiJaak PRO, make sure that you DO NOT 
select Prompt for Options in the Windows Capture Options dialog box. The 
Windows Capture Options prompt closes the pull-down menu because 
Windows may have only one menu open at a time. Deselect Prompt for 
Options and use the Hotkey method to capture the pull-down menu.

Q. Why can't I capture an icon in one of my Windows program groups 
using HiJaak PRO's Window/Object capture method?

A. Microsoft Windows 3.1 does not treat icons within program groups as separate 
entities, therefore, the Window/Object option will not outline a single icon, but 
only the entire program group. You may use HiJaak PRO's Area capture method 
to capture an icon, or you may capture the group and use HiJaak PRO's cropping 
feature to trim down the icon.

Q. Why can't I capture information from Hewlett-Packard's Dashboard 
using HiJaak PRO's Window/Object or Area capture methods.

A. HiJaak PRO will only capture an Area or Window/Object if your application is 
running in Dashboard's far left Extended Screen. It will, however capture any 
entire screen. To remedy this problem, either capture the entire screen using the 
Screen capture method and crop the excess information away, or move the 
application to the Far Left extended screen, change the view focus to that area, 
and try the capture again. 

Q. Why can't use Windows capture to capture screens from a DOS 
application running in full-screen mode under Windows?

A. You may be running into memory problems or compatibility issues by capturing 
this way.    If you need to capture screens from DOS applications, you should use 
HiJaak PRO's DOSCAP utility.    DOSCAP can be run by clicking on the DOSCAP icon
in your HiJaak PRO program group.    For instructions on how to use this 
procedure, click on the following:
Method 2: Exiting to DOS
Also, make sure you are using DOSCAP's hotkeys (the default is Alt-Ctrl) and not 
Windows Capture hotkeys (the default is Ctrl-Shift-C).



My Windows capture doesn't look right

Q. Why do I lose the outline around my captured window?
A.    HiJaak PRO gives you the choice of whether or not to add an outline border to 

your captured window.    If you would like to include this border, then select 
Border in the Windows Capture Options dialog box.

Q. What should I do if my captured screen, area or window/object doesn't 
look the way it originally did? 

A. If your captured image is completely black, has the wrong colors or just looks 
"funny," it could be related to your Windows video driver. If you experience these 
problems with HiJaak PRO's Windows capture, try using the regular VGA or the 
generic 800x600x16 color video driver in your Windows Setup.



It used to work, and now it doesn't?

If you are trying to perform an operation that has worked properly in the past, but 
doesn't seem to be working now, the most probable cause is that your HJPRO.SET 
set file has been corrupted.    To fix this problem, pull down the HiJaak PRO Setup 
menu and select Load Settings (Alt+s, l).    In the Load Settings dialog box, click 
on Defaults (Alt+f). Click on OK. Restart HiJaak PRO and try the operation again.

If you are working with PCL files, run the RESETPCL.BAT utility, installed in the 
HJPRO directory, which allows for the clearing of old font information. To use the 
utility, exit HiJaak PRO and go to a DOS prompt. Type RESETPCL with the path to 
your Windows directory (typically, C:\WINDOWS) as the command line parameter.

If this does not work, other important program files may have been corrupted or 
deleted. Try re-installing HiJaak PRO.




